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Introducao

Vocé sabe qual a principal funcdo do Adobe Illustrator? Vocé conhece os recursos que ele possui? Sabe como ele
pode ajuda-lo em suas criacdes? Neste capitulo, vocé conhecera essa poderosa ferramenta de criagdo e edicao de
imagens vetoriais. Apresentaremos seus principais elementos de interface, painéis, barras, menus e botdes. A
intencdo dessa apresentacdo é tornar vocé mais familiarizado com o software, para poder usar com mais
seguranca suas funcgdes.

Vocé também terd a oportunidade de descobrir alguns comandos basicos do programa, como iniciar um
trabalho, salvar, exportar e importar imagens externas a ele, visando inseri-las dentro de seu trabalho. Apés o
inicio da contextualizacdo, serdo apresentadas as ferramentas basicas de criacdo e desenho, como a caneta, o
lapis, os pincéis e as formas basicas, suas configuracdes e formas de preenchimento e edi¢do de caminhos.

Ao final, vocé tera contato com os efeitos que o Illustrator proporciona as artes, alguns herdados do Photoshop e
outros proprios dele mesmo, que podem melhorar a sua criagdo, com um visual mais rebuscado e de boa
qualidade visual.

Esperamos que vocé goste desse software que redefiniu o padrdo do mercado grafico gragas a sua estabilidade e
qualidade na finalizagdo das artes, e que possa utiliza-lo de modo a ampliar suas possibilidades de criacao de
imagens vetoriais.

Abragos e bons estudos!

2.1 Conceitos basicos

No trabalho com imagem digital, existem dois tipos de formatos: os bitmaps e os vetores. O primeiro formato
trabalha com pixels, pequenos pontos aglutinados que formam imagens; ja o segundo trabalha com linhas e
calculos matematicos que sdo refeitos sempre que a imagem estad sendo editada. Esses calculos sdo interpretados
por programas especificos que traduzem os cédigos em imagens.

Segundo Bertoletti e Camargo (2016, p. 71), as imagens bitmaps, também denominadas matriciais:

[..] sdo formadas por pixels, que sdo quadrados bem pequenos, cada qual com sua cor definida, e
que, reunidos, conformam determinada imagem. [Ja4 as imagens vetoriais] utilizam postulados
geométricos como curvas, linhas e poligonos em sua conformacgdo. Para descricdo desse tipo de

imagem sao utilizados vetores matematicos.

Neste capitulo, vocé conhecerd um poderoso software de manipulacdo de imagens vetoriais utilizado em grande
parte das graficas e agéncias de publicidade do mundo. Conhec¢a mais sobre a ferramenta e suas possibilidade a
seguir!

2.1.1 Ferramenta

O Adobe Illustrator é um programa desenvolvido pela Adobe System para funcionar como editor de imagens
vetoriais. Suas principais fung¢des sdo: criacdo de pecas graficas, embalagens, logotipos e ilustragdes. Ele faz parte
da suite de aplicativos Adobe Creative Cloud e é distribuido juntamente com programas como o Adobe
Photoshop e Adobe InDesign.

Em seu website, a Adobe Systems (2018) define o Illustrator como o “software padrao para graficos vetoriais
[que] permite criar logotipos, icones, desenhos, tipografia e ilustra¢des para impressao, web, video e dispositivos

moveis”.
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Atualmente, ele é considerado um dos melhores softwares para edicio de imagens vetoriais do mercado,
concorrendo com o CorelDRAW e o Inkscape. Cada um deles possui especificidades e diferencas na forma de

utilizacdo, mas todos possuem a mesma finalidade; cabe a vocé decidir qual deles lhe atende melhor.
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Figura 1 - Interface padrao do Adobe Illustrator CC no Windows.
Fonte: Elaborada pelo autor, baseada em ADOBE ILLUSTRATOR CC, 2018.

Por ser desenvolvido pela mesma empresa e fazer parte da mesma linha de produtos, é facil de identificar
elementos comuns nas interfaces dos programas da suite Adobe Creative Cloud, como o posicionamento das
barras de tarefas, dos menus e dos botdes que executam suas principais tarefas. Esses aplicativos sdo
disponibilizados por meio de assinaturas, que podem ser definidas de acordo com as suas necessidades, seja de

Design Grafico, de edicdo de fotos ou de edi¢do de videos.

VOCE QUER VER?

A Adobe Systems é uma empresa americana que redefiniu o mercado dos softwares de criagao

0O

K grafica, edicdo de video e web. Criada em 1982, ela langou uma linguagem de programacao que
auxilia na disponibilizacdo de informagdes visuais, o PostScript. A partir disso, ela criou
aplicativos como o Illustrator, em 1982, e o Photoshop, em 1987. Assim, ela trilhou um
caminho muito promissor na profissionalizacdo dos trabalhos graficos e multimidia. Saiba
mais sobre a histéria da Adobe assistindo ao seguinte video: <https://www.youtube.com
/watch?v=l1A9pCZhF]Sw>.

O Mlustrator permite a criacdo de pecgas graficas profissionais para impressdo. Ele ndo é o mais especifico para
criacdo de publicagdes editoriais como livros e revistas. Esse trabalho é melhor desenvolvido utilizando o Adobe
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InDesign, que oferece ferramentas especificas para esse fim. A Adobe criou programas especificos para cada
funcdo: o Illustrator cuida das imagens vetoriais e diagrama marcas, artes, ilustracdes e projetos para impressao;
o Photoshop é destinado ao tratamento de imagens bitmap e manipulacdo de fotos; ja o InDesign trata de
projetos editoriais. Mas ainda assim, eles sdo compativeis entre si.

Para utilizar o software, é importante conhecé-lo melhor. A seguir, sdo explicados cada item da tela para deixar
vocé mais familiarizado com suas fung¢des. Vamos 1a?

Barra de menus (item 1)

Reune os principais comandos do seu aplicativo, que estdo divididos em: Arquivo (File), Editar
(Edit), Imagem (Image), Objeto (Object), Tipo (Type), Selecionar (Select), Efeito (Effect), Exibir
(View), Janela (Window) e Ajuda (Help). Ela sempre estd posicionada na parte superior do
[llustrator ou na barra de menus do macOS.

Ao lado direito da barra de menu (ou abaixo dela no macOS), encontram-se as predefini¢cdes de
area de trabalho do Illustrator. Por meio desse menu, o usuario pode reconfigurar os painéis,
mostrando ou ocultando fun¢des de acordo com a finalidade do arquivo. Essas fung¢des sao
agrupadas em: Automacdo; Essenciais; Impressdo e Prova; Tipografia; Tracado; e Web. Ao clicar
em algum objeto na prancheta, essa barra se modificara para apresentar as seguintes opgdes
relativas ao objeto que esta sendo editado:

Organizar documentos: apresenta opc¢des de organizacdo do documento na area de trabalho do
aplicativo;

Painel de controle: oferece mais opg¢des para as ferramentas ou recursos para o elemento que esta
selecionado.

Barra de ferramentas (item 2)

E onde todas as ferramentas se encontram disponiveis para o desenvolvimento do projeto. Os
botdes que possuem uma seta branca no lado inferior indicam que existem mais opg¢des dentro de
menus, que aparecem ao manter o botdo do mouse pressionado ou ao clicar com o botdo direito.

Painéis de encaixe (item 3)

Possibilitam a edi¢do e monitoramento do arquivo, e a partir deles, é possivel alterar cores, alterar
e reorganizar pranchetas, modificar fontes, personalizar camadas, entre outras op¢des. Todos os
painéis de encaixe estdo disponiveis no menu Janela (Window). Ao abrir os painéis, ainda existem
setas que habilitam mais opgdes.

Barra de status (item 4)

Exibe informacgdes sobre o arquivo, ferramenta em uso, perfil de cor, quantidade de operagdes que
podem ser desfeitas ou refeitas, além de possibilitar a selecdo de zoom e de prancheta.

As réguas e guias auxiliam na diagramacio de imagem e identificam as coordenadas de localiza¢do na prancheta.
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Finalmente, as unidades de medida disponibilizam unidades de medidas para a edi¢do do arquivo, como guias,
redimensionamento, entre outras opg¢oes. Ao criar um arquivo, vocé escolhe alguns pardametros como unidades
de medidas, mas elas podem ser alteradas facilmente em: Editar (Edit) > Preferéncias (Preferences) > Unidades e

réguas (Units) > Escolher a unidade de medida desejada > Confirmar.

VOCE SABIA?

Apesar de a interface do Adobe Illustrator ser padronizada, ela pode ser alterada de acordo

com as suas necessidades, pois as janelas de encaixe sdo moveis e, sempre que vocé precisar

voltar a interface padrao, basta clicar em Janela (Window) > Espaco de trabalho (Workspace) >
Redefinir essenciais (Essencials).

Agora que vocé conhece a interface do Illustrator, chegou a hora de avangar um pouco mais em seus estudos. No
proximo topico, vocé conhecera os recursos basicos desse software. A primeira vista, ele pode parecer complexo,

mas aos poucos vocé percebera que ele é bem mais facil e intuitivo do que parece.

2.2 Recursos basicos

Além de conhecer cada um dos itens, é importante, também, descobrir quais os caminhos para se chegar a
algumas func¢des bdasicas, como abrir, criar, salvar e importar um arquivo. Com isso, vocé dard os primeiros
passos para a criacdo de sua arte. Vamos 1a?
¢ Abrindo um arquivo: na versdao Windows, existem duas formas de abrir arquivos no Illustrator:
arrastando o arquivo para dentro da janela do aplicativo ou pelo menu Arquivo (File) > Abrir... (Open...).
Na versdo macOS, vocé ainda pode abrir o arquivo arrastando-o para o icone no dock. Os principais
formatos suportados pelo Illustrator sao: .aj, .eps, .pdf, .dwg, .cdr (este tltimo com limita¢des nas versdes
compativeis), .jpg, .psd, .tiff, .png. A depender do tipo de arquivo aberto, é possivel edita-lo, como os
arquivos vetoriais .aj, .eps, .pdf, .dwg, .cdr. Para os formatos bitmap, o Illustrator ndo possibilitara a
edicao.

VOCE SABIA?

Na barra de titulo do Illustrator, além do nome do arquivo, é exibida a informacdo do modo de

cor configurado no arquivo. Caso deseje mudar, basta ir no menu Arquivo (File) > Modo de cor

do documento (Document color mode) > Escolher a opgao desejada (CMYK ou RGB).

¢ Criando um novo arquivo: para criar um novo arquivo no Illustrator, vocé deve clicar no menu
Arquivo (File) > Novo (New). A partir dai, o software ird abrir uma janela com os modelos predefinidos
pela Adobe e a possibilidade de configurar seu arquivo de acordo com as suas necessidades. E possivel
escolher entre varios perfis (presets) de arquivos: Mével (Mobile), para aparelhos como celulares e
tablets; Web, com formatos compativeis com a internet; Impressao (Print), especificos para impressao e
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cores em CMYK; Filme e video (Film & video), com formatos padrio de videos digitais; e Artes e
ilustracoes (Arts & illustration). Nesta tela, vocé também podera configurar os tamanhos das pranchetas
de trabalho em Largura (Width) e Altura (Height), as medidas padrdo em pixels, pontos, milimetros,
centimetros, escolher a Orienta¢do (Orientation) da prancheta, Quantidade de pranchetas (Artboards),
Sangria (Bleed) e Modo de cor (Color mode).

Prafiles  [Cistom]

= Auhcarced

enplates

Figura 2 - A partir do didlogo “criar novo documento”, é possivel escolher entre varios perfis e tamanhos de
arquivos, além de outras opgdes.
Fonte: ADOBE ILLUSTRATOR CC, 2018.

¢ Salvando um arquivo: para salvar o arquivo, clique no menu Arquivo (File) > Salvar (Save). Além disso,
vocé pode utilizar a opg¢do Salvar como (Save as), que ira abrir uma janela que permitira alterar o nome
do arquivo, a extensao (tipo de arquivo) e o local de salvamento. Ao escolher salvar um arquivo, o
[llustrator oferece diversos formatos, desde os formatos da Adobe, como o .aj, .ait e o .pdf, até formatos
largamente utilizados, como .eps, .svg e .svgz, todos vetoriais. Se vocé quiser salvar seu trabalho em
formatos bitmap, devera utilizar as op¢des de exportagdo do software, no menu Arquivo (File) > Exportar
(Export). O Illustrator possui, ainda, uma op¢ao especifica para salvar arquivos em formatos compativeis
para a internet. A opg¢ao Salvar para web (Save for web) possibilita o salvamento em JPG, PNG e Gif,
otimizados para exibicdo na internet e em formato comprimido. A partir da versdo CC 2017, o Illustrator
possui a op¢do Exportar para telas (Export for screens) que permite fazer o que é oferecido pelo Salvar
para web de forma mais automatizada e com a possibilidade de exportar arquivos em PDF.

Importando um arquivo: para importar um arquivo, clique em Arquivo (File) > Importar (Place). Essa
opc¢ao permite que sejam importados arquivos vetoriais ou bitmap, que vocé podera editar de acordo
com o tipo. O software ndo insere o arquivo importado na sua prancheta, ele cria um vinculo (link) para
ele e, sempre que vocé alterar o arquivo importado de lugar, o programa ira solicitar que vocé refaca a
ligagdo. Vocé ainda pode incorporar o arquivo importado ao seu arquivo do Illustrator, clicando no botao
Incorporar (Embed) da barra superior.
Agora que vocé ja sabe quais sdo os comandos basicos de manipulacdo de arquivos, vocé ird conhecer as
ferramentas de vetorizacdo e criacdo do software. Esse é o grande diferencial do Illustrator, uma poderosa

ferramenta de criacao vetorial.
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2.2.1 Vetorizacdo de imagens

Vetorizagdo é um processo que transforma imagens originalmente bitmaps em vetores, redesenhando seus
tracos o mais proximo possivel do original. A forma mais simples de vetorizar uma imagem é utilizando a
ferramenta Tragcado da imagem (Live trace), que refaz a imagem bitmap com tracados vetoriais de forma rapida,

seguindo alguns perfis pré-programados. Vocé podera alterar algumas configuracdes desses perfis, caso precise.
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Figura 3 - A partir da janela “Tragado da imagem”, é possivel vetorizar uma imagem.
Fonte: ADOBE ILLUSTRATOR CC, 2018.

Ao inserir uma imagem bitmap na sua prancheta, utilizando o menu Arquivo (File) > Inserir (Place), e clicando
sobre a imagem inserida e sobre o botdo Tragado da imagem, o Illustrator iniciara o tracado em vetor da
imagem. Sera feita a vetorizacdo padrdo, que pode ser alterada usando as op¢des da janela de Tracado da
imagem - apresentada apds apertar o botdo - ou vocé pode clicar na seta ao lado do botdo Tragado da imagem (
Image trace) para exibir essas predefini¢des antes de fazer o procedimento. Existem varias predefini¢des nessa
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funcao: Foto de alta fidelidade; Foto de baixa fidelidade; 3 cores; 5 cores; 16; Tonalidades de cinza; Logotipo
preto e branco; Esboco artistico; Silhuetas; Tracado; Desenho.

Nem sempre essa é uma boa opgdo para vetorizar suas imagens, pois a ferramenta ndo identifica todas as formas
e, principalmente em imagens com qualidade inferior, podem ser gerados vetores que nao se assemelham a
imagem original. Para resolver isso, vocé pode alterar as configuracdes na janela de Tracado da imagem, como
Numero de caminhos, Cantos, Diminui¢cdo ou Aumento do ruido da imagem, Método de mesclagem, Alterar a
forma do resultado entre preenchimento e tragado e Ignorar o fundo branco da imagem. Essas opg¢odes ficam
disponiveis ao clicar na op¢do Avangado da janela de Tracado da imagem. Se, ainda assim, o seu resultado ndo

for satisfatdrio, vocé podera fazer o tragado de forma manual, como sera descrito posteriormente.

2.2.2 Criagao e transformacao de formas basicas

Antes de falar sobre formas de criar, é importante definir alguns dos termos que utilizaremos aqui. Segundo
Dondis (2007, p. 23), “a caixa de ferramenta de todas as comunicag¢des visuais” sdo os seguintes elementos
basicos: o ponto, a linha, a forma, a dire¢ao, o tom, a cor, a textura, a escala, a dimensao e 0 movimento
Cada um desses elementos tem significativa importancia, desde o ponto, unidade de comunica¢do mais simples,
até o movimento, uma das for¢as mais dominantes. O ponto, segundo Vaz e Silva (2016), é o elemento
fundamental do cédigo visual, e a partir dele surgem as linhas (ou caminhos, nesse caso), que podem gerar uma
composicdo que, por sua vez, dara origem as formas.

Devemos lembrar sempre que o Illustrator é um software vetorial e o resultado de suas ilustracées possuem
pontos de ancoragem, al¢as de direcdo e outros elementos caracteristicos desse tipo de arte. Assim, toda arte
vetorial depende desse tipo de elemento para existir, diferente do bitmap, que é feito de pixels. O Illustrator
oferece diversas ferramentas para fazer ilustragdes, utilizando Segmentos (linhas retas e curvas); Formas
(desenhos delimitados, abertos ou fechados); Elementos (formas, tipografas, desenhos, imagens, tragos); e
Caminhos (linha delimitadora de uma forma).

Figura 4 - Parte da barra de ferramentas com op¢des para desenho de vetores.
Fonte: ADOBE ILLUSTRATOR CC, 2018.

E possivel utilizar formas basicas para a criacdo de artes no Illustrator. Clicando no botdo de formas (que possui
um retangulo), vocé pode iniciar a criacdo a partir delas, lembrando que, ao clicar e segurar o botdo do mouse
nesse item da barra de ferramentas, ele oferecerd outras opgdes de formas, sdo elas: retangulo, retangulo

arredondado, elipse, poligono, estrela e clarao.
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Ao clicar e segurar o botdo do mouse em cima dos icones que possuem uma seta preta, eles apresentam outras
op¢des de ferramentas ou de configuragdes da mesma ferramenta. Além disso, ao clicar duas vezes, alguns

desses botdes apresentam uma janela de configura¢des para as ferramentas.

2.2.3 Desenho de vetores com a Pen Tool

E possivel iniciar um desenho no Illustrator clicando no botio de linha e tragando uma simples linha reta, ou isso
pode ser feito a partir da utilizacdo de uma das canetas, disponiveis na barra de ferramentas, o que permitira a
vocé desenhar formas de modo livre, de acordo com as suas necessidades. Veja, a seguir, quais as ferramentas de
desenho de vetores.

o Ferramenta Caneta: oferece a possibilidade de desenhar livremente pontos que automaticamente se
ligam a outros e vao criando formas abertas ou fechadas, organicas ou geométricas. Vocé pode criar os
pontos, alcas e edita-los posteriormente, utilizando a caneta.

¢ Ferramenta Curvatura: desenha, ponto a ponto, curvas que vao se ligando as anteriores, formando
desenhos organicos fechados ou abertos. Vocé pode criar os pontos e algas e edita-los posteriormente,
utilizando a caneta.

Exemplo de caminho aberto
Exemplo de caminho fechado

Caminho

Ponto de dncora

Figura 5 - Exemplos de caminho aberto e caminho fechado.
Fonte: Elaborado pelo autor, 2018.

Como vocé pode ver na figura acima, o caminho é composto por partes que tém fungdes especificas: o no, que é a
juncdo entre as pontas dos caminhos; o caminho, que é a linha do vetor; a al¢a, que permite, quando editada,
alterar a curvatura do caminho; e os pontos de ancora, que ficam nas pontas das algas, e possuem a mesma
funcao.

e Ferramenta Lapis: assemelha-se a um lapis verdadeiro. Com ela, é possivel desenhar diretamente na
prancheta linhas retas, curvas ou mais complexas. Também é possivel apaga-las com a opgao borracha do
lapis, ao clicar e segurar o botdo da barra de ferramentas.

¢ Ferramenta Borracha: permite ao usuario apagar parte do vetor criado. No caso de um caminho
fechado, ao passar a borracha no meio, ela dividira a forma em duas formas fechadas, respeitando o limite
imposto pela borracha. Para cortar um caminho aberto, utilize a ferramenta Tesoura, que também
permitird abrir um caminho fechado, assim como a ferramenta Faca.

Esses sdo os elementos basicos que possibilitam o inicio das ilustragdes vetoriais no Illustrator. A partir delas,
pode-se criar qualquer objeto ou forma, com ou sem cores de preenchimento e contorno, como sera explanado

na sequéncia.
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2.2.4 Preenchimento e contorno da forma

O Illustrator permite que as formas sejam preenchidas por cor, quando fechadas. Algumas formas abertas
também podem ser preenchidas, mas o resultado pode nio ser tdo bom quanto o esperado. E recomendavel
selecionar a opc¢do “sem preenchimento” quando for utilizar formas abertas. Acompanhe a seguir as orientagoes.

Ao criar uma forma ou desenho, é possivel editar também a espessura e a cor do caminho. Vocé
pode fazer isso no painel de encaixe Caminho (Stroke), assim como torna-lo tracejado ou
pontilhado, além de inserir setas e outros elementos nas pontas dos caminhos.

Vocé pode preencher as formas com cores soélidas, gradientes ou texturas. Para isso, selecione a
forma que deseja editar, e na barra de ferramentas superior, escolha o quadrado de selecio de cor

da esquerda. Vocé também pode utilizar o painel de encaixe de cores para fazer isso.

Para preencher com gradientes, clique na forma, abra o painel de encaixe de gradientes e clique na
barra de gradiente. Nela, vocé podera selecionar as cores do gradiente e escolher angulo, raio,
além de definir se serd um gradiente radial ou linear.

O Preenchimento de Malha (Mesh) permite que vocé crie malhas especificas para seus objetos.
Essas malhas podem conter um grande nimero de pontos de diferentes cores, gradientes, luz e

sombra.

Cada ponto pode ser editado posteriormente, utilizando a mesma ferramenta. Esse recurso é
recomendavel para formas mais simples; em formas muito detalhadas e com muitas curvas, o
efeito pode nio ficar como desejado e, em alguns casos, a ferramenta ndo permitira sua utilizacao,

por conta do nimero elevado de curvas ou tragos.

Para criar uma malha, vocé deve selecionar o objeto no qual deseja criar a malha, clicar no botao
Preenchimento de Malha, na barra de ferramentas, e clicar nos pontos onde serdo criados os

pontos de cor ou luz.

As formas também possuem configuracdes de transparéncia e opacidade. Utilizando o painel de
encaixe Transparéncia (Transparency), vocé verd uma opg¢do de opacidade - a ser configurada de
acordo com sua necessidade - e um menu suspenso que oferece diversas formas de transparéncia
e fusdo dos objetos.

Essas op¢des mesclam os objetos e criam efeitos de cor e luminosidade diferenciados como
resultado da mistura.

E possivel criar mascaras de transparéncia no painel de encaixe, selecionando o objeto e clicando
no botdo Criar mascara (Make mask). Com esse movimento, o software ira abrir um segundo nivel
de edicdo e vocé poderad, a partir da criacdo de uma forma preenchida com cor sélida ou gradiente,

definir sua forma de transparéncia.

A cor preta é utilizada para definir o que ird aparecer, e a cor branca definird o que ficara
transparente na prancheta. Para sair do nivel de edigdo de mascara, clique duas vezes no primeiro
quadrado do painel de encaixe.
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Essas ferramentas mais basicas ddo uma ideia das possibilidades do programa em suas maos, mas podemos
avancgar ainda mais e conhecer as ferramentas e efeitos mais poderosos que ele oferece. Com isso, vocé podera

criar mais e melhor. Vamos 14?

2.3 Recursos avancados

0 software que vocé esta tendo a oportunidade de conhecer possui centenas de recursos, desde os mais basicos
até os mais avancados. Agora, vocé vera os recursos mais avangados do Illustrator, como trabalhar com Camadas
(Layers), utilizar os Pincéis (Brushes), a mistura de objetos (Blends), os filtros e efeitos disponibilizados para
refinar seu trabalho e torna-lo mais atraente, além de oferecer algumas facilidades na modificacdo de aspectos
do seu projeto.

Vocé percebera que alguns desses efeitos sdo muito semelhantes aos que encontramos em outros softwares de
manipulacdo bitmap, como o Photoshop, e isso pode deixar vocé ainda mais familiarizado com o programa.
Porém, o Illustrator oferece também outros efeitos que ndo sdo encontrados em muitos softwares de

manipulacdo de imagens em vetor. Pronto para conhecé-los?

2.3.1 Camadas (Layers)

A utilizacdo de camadas simula a criagdo de laminas sobrepostas a prancheta principal do arquivo. Essas
pranchas podem ser ativadas ou desativadas de acordo com as suas necessidades, assim como ter a edi¢do
bloqueada, para evitar que sejam alteradas, movidas ou apagadas durante a criacdo da arte. Acompanhe a seguir.
Para criar uma camada, ative o painel de encaixe Camadas (Layers), que ird mostrar uma camada apenas. Essa
camada estd inserida no nivel da prancheta. Para criar uma nova camada, vocé deve clicar no icone que simula
uma folha de papel com a ponta dobrada, chamado Criar nova camada. Essa nova camada sera inserida
imediatamente acima da anterior, e vocé podera trabalhar nela. Tudo o que for inserido nela ficara acima dos
objetos da camada abaixo.

Para evitar que a edi¢do da camada superior modifique os objetos da camada inferior, vocé deve clicar no espago
em branco entre o icone do olho e o quadro que exibe a cor da camada. Assim, ativara o bloqueio de camada, com
o icone de um cadeado. Isso significa que, até ser desativado, esse bloqueio ird proteger a camada de qualquer
alteracdo ou selecdo dos seus objetos.

Vocé também pode esconder camadas. Para isso, basta clicar no icone do olho que aparece do lado esquerdo de
cada camada. Para reexibir o contetido da camada, clique no mesmo espago onde o icone do olho se encontrava.
Outras op¢des de camada aparecem ao clicar no icone do menu do Painel. Com essas opgdes, vocé podera
duplicar camadas, mesclar as camadas, nivelar todas as camadas em uma sé, criar mascaras de recorte
(posicione um objeto sobre o outro e clique no primeiro icone a esquerda, na parte inferior do painel de encaixe;
0 objeto superior servird como mascara para os objetos inferiores), ocultar camadas e ativar modo de
isolamento (que permite a edicdo isolada de uma camada).

0 trabalho em camadas é recomendavel, principalmente, quando a quantidade de elementos na prancheta é
grande, evitando que ocasione perda de trabalho ou desorganizacao dos objetos visiveis.

2.3.2 Pincéis

A ferramenta Pincel oferece a simulacdo de um pincel real, e com ele, pode-se fazer uso de diversas texturas, que
serdo convertidas em vetores ao final da utilizacdo. Para operar com o pincel, clique no botao Pincel (brush) da
barra de ferramentas, o que ira habilitar o seu uso no formato mais simples. Ja para alterar o tipo de pincel
(arredondado, chanfrado, achatado etc., além de alterar a espessura e o peso do pincel), clique duas vezes no
botdo Pincel, abrindo a janela de Op¢oes da ferramenta Pincel (Brush Options). Também é possivel alterar o tipo
de pincel e até selecionar pincéis artisticos no painel de encaixe Pincéis (Brushes).
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2.3.3 Mescla de objetos

A Mescla de objetos (Object blend) permite criar fusdes de formas e cores entre dois objetos. Essas misturas

podem gerar efeitos de transi¢do de cores e da forma propriamente dita dos objetos utilizados.

Figura 6 - Exemplo da utilizagdo de uma mistura para distribuir cores suavemente entre dois objetos.
Fonte: ADOBE ILLUSTRATOR CC, 2018.

Para criar uma Mescla de objetos, clique no botdo Mesclagem de objetos da barra de ferramentas, depois no
objeto inicial e em seguida clique no objeto final. Vocé verd que essa mistura ndo sera suave. Para alterar as
propriedades de mistura, clique duas vezes no botdo. Assim, serd apresentada a janela de op¢des da ferramenta,
0 que permitird alterar o nimero de etapas da mistura para obter uma cor suave, um numero especifico de
etapas ou a distancia especifica entre as etapas.

Vocé ainda pode editar o caminho que a mesclagem percorre, utilizando a ferramenta de selecdo direta (seta
branca), que permitira a vocé editar uma linha que mostra o percurso da mistura. Fazendo isso, vocé pode editar

pontos com a caneta e criar mais movimento para sua arte.

2.3.4 Filtros e efeitos

0 menu Efeito do Illustrator possui uma lista de efeitos vetoriais e bitmap que podem ser aplicados aos objetos
na prancheta. Alguns desses efeitos sdo trazidos do Photoshop por possuirem um perfil mais préximo do
programa-irmao do Illustrator. Cabe observar aqui que, sempre que se insere um efeito nos objetos vetoriais, o
programa guarda-os nas informag¢des do arquivo e acumula-os no painel de encaixe Aparéncia, onde podem ser
excluidos e adicionados sempre que necessario, conservando as formas originais. Esses efeitos fazem o
programa utilizar mais recursos, como memdria e processador, além de deixarem o arquivo com mais peso de

armazenamento.
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Figura 7 - O Illustrator oferece muitas op¢des de efeitos, sendo alguns trazidos do Photoshop.
Fonte: ADOBE ILLUSTRATOR CC, 2018.

L S . . . . S .

Os Efeitos do Illustrator oferecem uma lista de efeitos que podem ser aplicados apenas em vetores. Nos objetos
rasterizados (em bitmap), esses efeitos nao terdo o mesmo resultado. Veja em que consiste cada um dos efeitos:
3D

Permite a insercao de efeitos de terceira dimensao, como Extrusao e bisel (Extrude & bevel); Revolugao (Revolve
); Rotagdo (Rotation).

Caminho
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Insere op¢des de contorno no objeto selecionado e possibilita o deslocamento do contorno do objeto para torna-
lo mais espesso.

Converter em forma

Altera a aparéncia do objeto para Retangulo, Retangulo Arredondado ou Elipse.

Deformacao

Possui uma série de formatos predeterminados para deformar o objeto ou texto em formas pré-definidas.
Distorcer e transformar

De forma semelhante a Deformacgdo, Distorcer e transformar aplica algumas formas mais organicas ao objeto
selecionado. Para criar uma forma manualmente, é possivel aplicar o efeito Distor¢do com envelope, no menu
Objeto > Distor¢do com envelope > Criar com malha.

Estilizar

Oferece alguns efeitos que simulam sombreamento e brilho aos objetos, como Brilho externo, Brilho interno,
Cantos arredondados, Difusao, Rabiscar, Sombra.

Filtros SVG

Fornece uma série de efeitos especificos para o formato SVG.

Marcas de corte

Insere marcas de corte para impressdo ao redor do objeto selecionado.

Rasterizar

Cria um objeto rasterizado (bitmap) a partir de um vetor e permite que o vetor seja recuperado, caso necessario.
Existe uma opg¢do no menu Objeto > Rasterizar que executa uma func¢do semelhante, mas que nao oferece a
possibilidade de ser desfeita.

Pathfinder

Permite a combinagdo de objetos vetoriais a partir de Adicionar, Intersecdo, Excluir, Subtragido, Menos, Aparar,

Mesclar, Mistura, Mistura suave, Trapping. Na imagem a seguir, é possivel verificar o resultado desses efeitos.
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Figura 8 - Simulacdo da aplica¢do do efeito Pathfinder.

Fonte: Elaborado pelo autor, 2018.

VOCE SABIA?

A Adobe disponibiliza em seu website uma série de tutoriais e textos informativos sobre a

utilizacdo das ferramentas dos seus programas. Vale a pena conhecer mais sobre cada

ferramenta. Tudo o que estd disponivel no site é gratuito e de facil compreensdo. Acesse: <
https://helpx.adobe.com/br/illustrator/user-guide.html>.

Além desses efeitos, o Illustrator oferece, em Efeitos do Photoshop, uma lista de efeitos trazidos do Photoshop
que podem ser aplicados tanto em vetores, quanto em imagens rasterizadas. Esses efeitos sdo renderizados e
reaplicados sempre que a forma é atualizada, transformando-a temporariamente em imagem rasterizada.

Confira-os!
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Galeria de efeitos

Galeria de 47 efeitos artisticos importados do Photoshop que podem ser aplicados nos objetos da
prancheta, com a facilidade de simular a aplicagdo antes de fazé-la. Os mesmos efeitos estdo
disponiveis no menu Efeitos.

Lapis de cor

Simula o desenho de uma imagem com lapis de cor em um plano de fundo, mantém arestas

importantes e aplica o efeito de hachura, além de suavizar o plano de fundo.

Recorte de arestas

Simula uma composi¢do de recortes de papel colorido, aplica silhueta nas imagens de alto

contraste e textura de papel colorido em camadas nas partes coloridas da imagem.

Pincel a seco

Reduz a escala cromatica da imagem e aplica uma simulagdo de pincel a seco sobre o objeto.

Foto granulada

Unifica elementos com suavizacdo de tons e aplicacdo de padrdo mais saturado em &reas mais

claras.

Afresco

Aplica tragos curtos e arredondados a imagem, aproximando-se da técnica de pintura.

Néon

Aplica camadas de brilho aos objetos, coloriza a imagem, mas suaviza a aparéncia. Permite a
selecdo de cor de destaque.

Toques de tinta

Aplica um efeito de pintura na imagem. E possivel selecionar o tipo de pincel que sera aplicado.

Espatula

Simula o efeito de uma tela pintada com pouca tinta, reduzindo os detalhes.
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Plastificacao

Aplica uma textura de plastico brilhante em cima da imagem.

Arestas posterizadas

Altera o numero de cores da imagem para aproximar-se do valor de posterizagido selecionado.

Também define linhas pretas nas arestas da imagem.

Pastéis asperos

Simula o efeito de giz pastel colorido sobre o fundo texturizado.

Bastdo de borrar

Suaviza a imagem com tragos diagonais curtos borrados ou manchados nas areas mais escuras.

Esponja

Texturiza a imagem com cores contrastantes.

Tinta-base

Efeito de pintura na imagem com a sobreposicdo de textura.

Aquarela

Simplifica os detalhes da imagem para simular o efeito aquarela e satura cores em altera¢des de
tom.

Utilizando séries de efeitos, seu projeto pode ganhar uma outra definigdo. Porém, utilize-as sempre com cuidado
para ndo exagerar e deixa-lo visualmente sobrecarregado, e esteja atento, ainda, para que o tamanho do seu
arquivo e uso de memdria ndo atrapalhem o seu trabalho. Existem algumas regras que auxiliam no
desenvolvimento de projetos graficos, e a Gestalt, que estuda a percepg¢ado e forma, é uma delas. Que tal aprender

um pouco sobre esse assunto?

2.4 Aplicagao

Um detalhe a que devemos estar atentos, é que a composicdo da imagem deve ser pensada e bem organizada.
Pensando nisso, existem recomendacdes especificas da area do design e da psicologia sobre tal composigao.

Em estudos sobre psicologia e percepgdo, a Gestalt criou um conjunto de recomendagdes para composi¢ao visual
que pode auxiliar vocé no desenvolvimento de seus layouts (GOMES FILHO, 2004). A Gestalt surgiu na Alemanha,
no inicio do século XX, e teve como principais formuladores Kurt Koffka (1886-1941), Wolfgang Kohler (1887-
1967) e Max Wertheimer (1880-1943). O termo Gestalt, em portugués “esséncia” ou a “forma da forma completa

de uma entidade”, é genericamente traduzido apenas como “forma”.

EAD.OL

-17 -



Conhecida como “teoria da forma” ou “teoria da boa forma”, é aplicada também no campo do design, ndo
obstante tenha surgido no campo da filosofia e se consolidado no campo da psicologia. A partir dos estudos
nesses campos, os pesquisadores dessa linha de pensamento criaram leis para favorecer analises e
interpretacdes da forma do objeto. Tais leis sdo classificadas como:

Unidade

Relacionada a forma, pode ser representada em um tinico elemento ou em parte de um todo.

Segregacao

A capacidade de reconhecer as unidades de forma separada do todo ou de partes dele.

Unificacdo

Coesdo visual entre equilibrio, harmonia, ordenacdo visual e coeréncia da linguagem ou estilo formal das partes
ou do todo.

Fechamento

Formacdo de unidades de acordo com forcas de organiza¢do da forma.

Continuidade

Sequéncia e fluidez sem quebras ou interrupgdes; facilite o reconhecimento e compreensio das informagdes
para o seu leitor, utilize os mesmos objetos, cores e localizagdes das informag¢des no layout; isso reduz a
sobrecarga da informacdo e torna a leitura mais fluida. Ainda assim, evite exagerar nas repeti¢oes, que podem
tornar seu layout monétono.

Proximidade

Estimulos semelhantes normalmente se agrupam em unidades e constituem partes de um todo. Criar
agrupamentos de elementos semelhantes auxilia no reconhecimento das informagdes pelo olho humano.
Semelhanca

Igualdade de forma e de cor cria agrupamentos de partes semelhantes.

Pregnancia da forma

Lei basica da percep¢do visual da Gestalt, trata da organiza¢do formal da imagem, equilibrio, contraste, clareza
visual. Utilize diferenciacdo de elementos e entre os elementos e o fundo para destaca-los e tornar sua leitura

mais simples.

VOCE QUER LER?

0 livro “Design Grafico aplicado a Publicidade”, de Marco Mazzarotto, oferece um guia pratico e
Q repleto de recomendagdes para seus projetos graficos. Ele aborda desde conceitos estéticos,
nocdes sobre cor, composicdo, tipografia e produgio grafica.

Buscar respeitar essas leis pode garantir a boa percepc¢do e leitura de formas e informag¢des em projetos
impressos e digitais (por meio da interface). Além do efeito visual, a Gestalt promove efeitos psicolégicos no
publico, teoria comprovada pelos estudos feitos durante sua elaboracdo (GOMES FILHO, 2000). Nio é

obrigatério seguir todas as leis, mas é recomendavel observa-las e buscar aplica-las quando cabivel.

2.4.1 Preparando o layout

Uma vez compreendidas as leis da Gestalt, é hora de preparar o seu layout! Para isso, crie um novo arquivo e
defina suas regras. Considere que, para impressoes de tamanho até A3 (297mm x 420mm), é importante utilizar
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a unidade de medida por milimetros. Acima desse formato, é recomendavel utilizar centimetros como padrao. Ja
para formatos digitais, é mais comum fazer uso da unidade de pixels, mais utilizada em formatos web e

eletronicos.

VOCE O CONHECE?

Conhecido como criador do site Abduzeedo, repleto de referéncias para designers do mundo

inteiro, Fabio Sasso é um brasileiro de Porto Alegre que atualmente é também designer sénior

do Google. Ele é uma boa fonte de informagdes sobre referéncias e tutoriais de uso dos

softwares da Adobe. Acesse o site e conheca mais sobre seu trabalho: <https://abduzeedo.com

/collections>.

Com isso em mente, siga 0s passos a seguir.

Em primeiro lugar, configure o seu documento de acordo com o tipo de trabalho que vocé esta desenvolvendo.
Os projetos destinados a impressdo devem sempre utilizar o modo de cor CMYK; ja os projetos digitais ou
eletronicos devem utilizar o modo de cor RGB. Utilizar o modo de cor errado pode alterar a saida do seu arquivo
e prejudicar a exibicdo ou impressao dele.

E importante, ainda, que vocé planeje o seu layout, ou seja, nio componha o seu projeto de qualquer forma.
Busque criar uma légica visual, um caminho para que a sua mensagem seja compreendida, e agrupe objetos
semelhantes e informac¢des semelhantes, deixando mais afastadas as informag¢des menos importantes. Em
resumo, evite sobrecarregar o layout.

Com o layout planejado, lembre-se de ativar a régua do Illustrator (com o comando CTRL + R ou Command + R
). Com isso, vocé poderda utilizar linhas-guia para alinhamento (para criar uma linha-guia, clique na régua e
arraste-a na direcdo do limite que vocé deseja configurar para seus objetos, assim, o software ird desenhar uma
linha paralela ao ponto da régua que vocé arrastou). Vocé pode definir quantas linhas-guia precisar. Nao se
preocupar com o alinhamento de sua arte pode deixar seu layout com um visual amador.

Também os grids - ou grelhas - auxiliam na organizac¢do visual dos elementos do layout, podendo ser utilizados
em toda a prancheta e melhorando o alinhamento dos objetos.

Projete o seu layout com margens que o facam fluir e respirar; divida sua pagina em colunas, de acordo com a
prioridade da leitura da informacdo e agrupe as informagdes semelhantes. Configure as calhas (espagos entre as
colunas) de modo que mantenha o layout visualmente leve e crie mddulos que definam espacos especificos na
sua arte. Ndo se preocupe, as linhas-guia ndo saem na impressao.

Em relacdo a cartela de cores utilizada em seu projeto, € importante selecionad-la cuidadosamente. Nesse
sentido, busque trabalhar com cores que harmonizem entre si e, caso tenha dudvidas, utilize ferramentas que
podem auxilid-lo nessa tarefa.

O Illustrator oferece ferramentas especificas para cores, como o painel de encaixe de cor, que permite
selecionar cores de acordo com sua necessidade e com o tipo de cor do seu documento. Nele é possivel combinar
cores RGB, CMYK, Hexadecimais, HSB, Escala de cinza. Também ¢é possivel alterar as cores do seu projeto
utilizando o guia de cores, que oferece novas combinagdes possiveis com base no que ja foi criado. Essas novas
cores podem seguir o padrdo monocromatico, analogo, complementar ou vocé pode criar uma sele¢ao prépria da
cartela de cores. Ainda é possivel fazer uso de amostras de cor, que oferecem uma cartela de cores que podem
ser utilizadas, desde as cores padrao do Illustrator até uma biblioteca com conjuntos especificos, como cores de
substancias metdlicas, cores infantis, cientificas, relativas a natureza, entre outras que podem facilitar a selecdo
das cores do seu trabalho.
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VOCE SABIA?

0 Adobe Color Wheel é uma ferramenta gratuita que permite criar cartelas de cores para seus

documentos de forma automatizada. Vocé seleciona as cores e o tipo de harmonizag¢ido

desejado (monocromatico, complementar, analogo, triade, composto, sobras ou personalizado)
e ele lhe oferece uma cartela de combinagdes para seu trabalho. Acesse a ferramenta em: <
https://color.adobe.com/>.

Agora que vocé ja aprendeu a preparar o seu layout, vamos falar sobre os textos, uma das principais ferramentas
de trabalho de um designer. A manipulacdo de textos pode tornar o seu trabalho um grande diferencial, ou pode

causar o fracasso do seu projeto caso ndo seja bem elaborada.

2.4.2. Manipulagao de textos

A ferramenta de texto do Illustrator possibilita a criagdo de textos a partir do ponto clicado na prancheta ou
dentro de uma area, que pode ser uma forma ja criada ou desenhada por vocé, arrastando o cursor dentro da
prancheta. Ao pressionar e manter o botdo de texto, sdo apresentadas outras possibilidades para essa
ferramenta, como Texto vertical (disponibilizado verticalmente), Texto em area (o texto preenchera uma area
delimitadora, que pode ser uma forma basica ou uma forma criada pelo usuario), Texto em caminho (o texto
seguird um caminho desenhado com a caneta, o lapis ou a linha. Também é possivel que o texto contorne uma
forma fechada), Texto vertical no caminho (o texto pode ser inserido de forma vertical, seguindo o caminho
criado anteriormente).

VOCE QUER LER?

Q 0 livro “Producdo grafica, arte e técnica na direcdo de arte”, de Antonio Celso Collaro, explica

os termos utilizados pela tipografia, além de contar a histdria do tipo e descrever alguns
conceitos que podem auxilid-lo na compreensdo das artes tipograficas, que deram origem ao
Design Gréfico.

0 painel de encaixe de tipo e paragrafo pode ser ativado em Janela (Window) > Tipo (Type) > Caractere (
Character) e possibilita a configuracdo dos aspectos referentes ao texto. Nele, é possivel alterar fonte, a
espessura da fonte, tamanho do texto, espacamento entre os caracteres, espacamento entre as linhas, rotacao
dos caracteres, deslocamento da linha-base, alterar o kerning entre dois caracteres, definir caixa alta para todo o
texto, ativar a versalete, texto sobrescrito, texto subscrito, sublinhado e tachado, além de permitir a configuracdo

da lingua que esta sendo utilizada no texto para hifenizacao.
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Figura 9 - A partir do painel de encaixe de tipo e paragrafo, é possivel definir diversos aspectos relacionados ao
texto.
Fonte: ADOBE ILLUSTRATOR CC, 2018.

Na aba de paragrafo, essa janela permite que sejam configurados o alinhamento do texto (centralizado,
justificado, alinhado a esquerda ou a direita), recuos a esquerda ou a direita, recuo a esquerda na primeira linha
e espaco antes e depois do paragrafo.

Na aba OpenType sdo oferecidas configuragdes especificas para esse tipo de fonte, como suas ligaduras,
alternativas contextuais, figuras, posicionamento, swash, alternativas estilisticas, alternativas de titulos, ordinais,

fragdes.
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CASO

Uma empresa solicitou a uma agéncia que fosse criado o convite para a confraterniza¢do de fim
de ano. Esse convite deveria ter as informagdes basicas sobre o evento, como local, horario,
data e solicitagdo de confirmagao (RSVP).

Como se tratava de uma confraternizagdo de fim de ano, o convite deveria ter o visual préximo
de uma festa, mas deveria refletir proximidade e fraternidade, que sdo sentimentos mais
condizentes com o clima das festas de fim de ano e natal.

A agéncia precisou de uma imagem de banco de imagens (em boa qualidade), da marca do
cliente (vetorial) e dos textos descritivos das informacdes do evento. O diretor de arte iniciou o
projeto com a criagdo das linhas-guia para desenvolver um grid que deixasse o projeto mais
profissional, inseriu a foto no fundo do convite, incluiu o titulo com caixa alta na parte superior
central, as informagdes do evento em um box na area inferior a direta e um texto de apoio
solicitando a confirmacgdo de presenca até dois dias antes da festa, a fim de que a empresa

pudesse prever a quantidade de pessoas presentes.

Mas por que o diretor de arte optou por essas escolhas? Porque a utilizacdo de boxes com
informacgdes textuais pode melhorar a leitura dos textos quando estes sdo inseridos em cima
de imagens ou texturas. Ja a utilizacdo da caixa alta chama a ateng¢do para o texto do titulo e a
imagem torna a peca mais convidativa. E vocé, como faria esse convite?

Agora que vocé viu os principais comandos, ferramentas e efeitos utilizados no Illustrator, vocé ja tem as bases
para iniciar uma composi¢do grafica. Que tal testar os conhecimentos adquiridos até aqui? Abra o programa e
crie um cartdo de visitas: é uma arte simples e utiliza principalmente textos e formas basicas. Uma dica: o
tamanho padrido dos cartdes é de 90mm x 50mm. Veja que a altura sempre é mencionada por ultimo em

medidas.

Sintese

Ao longo deste capitulo, vocé conheceu o Adobe Illustrator, um dos mais famosos programas de edi¢do e
manipulagdo de vetores e diagramacdo de materiais graficos do mercado. Como vocé pdde perceber, ele é um

software muito completo e poderoso e pode oferecer mais do que suas ferramentas basicas.

Neste capitulo, vocé teve a oportunidade de:

¢ conhecer os conceitos de utilizacdo do programa;

e aprender sobre a interface padrdo de instalagdo e formas de configuragdo dela;

e ter contato com o conceito de vetorizagdo e ferramentas que podem ser utilizadas para executa-la;

e compreender o processo de criacdo e transformagao de formas basicas;

¢ ter nogdes do processo de criagcdo de desenhos vetoriais com a caneta;

e aprender a configurar os contornos e preenchimentos;

e descobrir como trabalhar com camadas;

e estar apto a utilizar os pincéis oferecidos pelo programa;

¢ conhecer como aplicar e definir os filtros e efeitos que compdem o software;

e aprender a manipular imagens e textos.
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